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1. Please read and follow the installation instructions on the following 
pages for a trouble-free installation! 

 

2. Do not drop your camera as this can result in serious damage. 
 

3. Only use the supplied power supply unit if your camera comes with one. 
 

4. Do not point the camera to a bright light source like the Sun without the 
appropriate filters as this will damage the sensor. 

5. Disconnect the camera from the computer when not in use. 

6. Treat the camera glass window with the same care as you would of a 
photographic lens. 

CAUTION 

! 

Manufacturer’s Warranty 

This product has a 12 month back to base warranty. For after 
sales support, please contact Opticstar at: info@opticstar.com 

 

mailto:info@opticstar.com
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Introduction 
The PL-131 series of video cameras include the PL-131C COOLAIR (colour model) and the PL-

131M COOLAIR (monochrome model). The PL-131 is the successor to the popular PL-130 but 

includes a number of significant enhancements such as: 

 

• Twice the speed and the frame rate. 

• Higher light sensitivity. 

• Improved dynamic range and image quality. 

• Region of Interest (ROI) in hardware. User definable. 

 

The PL-131 achieves frame rates of up to 22 frames per second (FPS) at full resolution: 1280x1024 

pixels, or up to 80 FPS at 640x480 pixels or up to 220 FPS at 320x240 pixels. 

 

The PL-131 is suitable for imaging the planets, the Moon and the Sun. The camera is also suitable 

for microscopy when fitted with an appropriate attachment. 

 

 

 

 

 

 

 

Software Support 

The maximum frame rates are possible in conjunction with the etAMACAP and Opticstar View 

software applications that are included on the bundled CD. Alternatively, if the emphasis is to 

process individual frames rather than a video stream, then the PL-131 can be used with the 

following software applications: 

• Nebulosity for image processing (Nebulosity Lite included on the CD). 

• PHD Guiding for auto-guiding (included on the CD). 

• AstroArt for advanced image capture, image processing and auto-guiding. 

• MaxIm DL for advanced image capture, image processing and auto-guiding. 

 

Package Contents 

This Setup Guide includes instructions for the Opticstar PL-131 and Opticstar AG-131. The AG-

131 includes the PL-131 camera plus the Shoestring GPUSB interface for telescope control. Prior 

to the installation, please ensure that the following items are included in the box. 

 

Opticstar PL-131 contents: 

• Opticstar PL-131 video camera. 

• CS to 1.25” telescope adapter. 

• USB cable. 

• Software CD. 

 

Additionally, the AG-131 includes the following items: 
• Shoestring GPUSB interface box for telescope control via the Guide Port (ST4). 

• Coiled cable to connect the GPUSB to the Guide port on the telescope mount. 

Please note that for solar photography, the camera should be 

used only with an appropriate solar telescope and/or solar 

filters. 
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Camera Installation 
The minimum computer system requirements are the following: 

• Windows (32-bit or 64-bit) 7/8/10/11 with the latest update.  

• USB 2.0 port for the camera. 

 

 

 

 

 

 

 

 

There are several pieces of software to install in order to add support for the PL-131 camera to 

Windows. It is not necessary to install all the supplied software but the Windows drivers and 

Windows DirectShow support (steps 1 & 2) should be installed as a minimum. The remaining 

software may be installed as needed depending on the user’s specific application. 

 

1. Windows DirectShow software for the PL-131. 

2. Windows software drivers for the PL-131. 

3. EtAMCAP application software for camera control and video capture. 

4. Opticstar View application software with more advanced functions and usability. 

5. Nebulosity Lite for single shot image capture and processing. 

6. PHD Guiding for telescope auto-guiding. 

7. Plug-in for AstroArt support (you must already have AstroArt to use this). 

8. Plug-in for MaxIm DL support (you must already have MaxIm DL to use this). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Anti-virus software may attempt to block the software 
installation. In such cases the anti-virus software should be 

temporarily disabled. Otherwise, when prompted, add the 

installation files to the trusted list. 

The installation of the software should be carried out by a user 

with Windows administrator permissions. Otherwise, the 

installation may fail. 

Please ensure that the camera is not connected to the computer 

yet. 

The camera does not incorporate any optics and therefore it 
cannot reach focus by itself. A C/CS mounted lens must be used 

with the camera or it must be attached to a telescope with the 
nosepiece adapter that is included with the camera. To attach it 

to a microscope, please use an appropriate attachment. 
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Installing Software for Windows DirectShow  

The first step is to install software that makes the PL-131 compatible with Microsoft’s Windows 

DirectShow model. Such compliance allows the PL-131 to be used with etAMCAP. 

  

1. Navigate to the DirectShow folder on the CD and open the appropriate program for your 

camera. There are two options: 

• PL-131C-setup.exe for the colour camera. 

• PL-131M-setup.exe for the monochrome camera. 

 

2. A message will appear “Welcome to the Device Driver Installation Wizard”. Click on the 

Next button to continue. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
           Step 1: Open the appropriate installation program.                     Step 2: Click Next to start software installation. 
 

3. Windows may display a warning message such as Windows can’t verify the publisher of this 

driver software. Select “Install this driver anyway” to continue. 

 

4. The next message will confirm that “The drivers are now installing…”. 

 

 

 

 

 

 

 

 

 

 

 

 
             Step 3: Ignore the Windows warning.                                     Step 4: Installation in progress. 
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5. Windows should confirm that the “Drivers were successfully installed on your computer”. 

Click Finish to continue. 

 

6. Finally, if Windows asks to restart the computer, select “Yes”. 

 

 

 

 

 

 

 

 

 

 

 

 

 
               Step 6: Drivers installed successfully.                          Step 7: Restart the computer. 
 

 

 

 

DirectShow support can be removed from the Windows Control 

Panel independently of the camera’s Windows software drivers. 
Click the Programs and Features or Apps & Features, and 

remove the entry headed “PL-131…”. 
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Installing the PL-131 Driver Software (32-bit or 64-bit) 

Please follow the instructions below in order to install the Windows drivers for the camera. 

 

1. Insert the CD in the drive. 

 

2. Connect the camera to a USB 2.0 port on your computer. 

 

3. A window will appear with the heading Found New Hardware, giving three options. 

Select “Locate and Install Driver Software”. Windows will search for the camera drivers. 
 

       Step 3: Searching for driver software.  

 

 

 

                    Step3: Install driver software. 

 

4. Windows will ask for the CD that came with camera (insert the CD if not present). 

 

5. The drivers should now be installed and you can proceed on page 11. Otherwise, if 

Windows fails to find the drivers, it will display that Windows failed to find the driver 

software and prompt for action. Select, Browse my computer for driver software. 

 

 
               Step 5: Windows failed to find driver software.                             Step 5: Browse computer for drivers. 
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6. The drivers are located in the Drivers\PL-131C (colour camera) and Drivers\PL-131M 

(monochrome camera) folders on the CD. Each folder contains a 32-bit and a 64-bit sub-

folder. Direct Windows to the appropriate folder. Windows will now install the driver 

software. 

 

7. Sometimes, Windows will fail to identify the drivers. If this is the case, a message box will 

appear saying that “Windows was unable to install your 1.3M USB2.0 Camera”. 

 

 
                Step 6: Direct Windows to the Drivers folder.                          Step 7: Unable to install the camera. 

 

 

8. In this case, the driver software should be installed manually. Click on the Start button on the 

Windows desktop and from Settings > Control Panel, select Device Manager. The camera 

should appear in the list with an explanation mark next to it, indicating that the drivers have not 

been installed yet. 

 

9. Right-click on the camera description and from the pop-up menu select Update Driver 

Software. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Step 8: Open Device Manager to locate the camera.                            Step 9: Update the driver software. 
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10. Windows will ask “How do you want to search for driver software?”. Select “Browse 

my computer for driver software” to continue. 

 

11. On the next dialog box select “Let me pick from a list of device drivers on my 

computer”. 

 

 
                   Step 10: Browse for driver software.                        Step 11: Pick from a list of device drivers. 

 

12. Windows will ask to Select your device’s type from the list below. Select “Imaging 

devices” and click on the Next button. 

 

13. On the next message box Windows will display: Select the device driver you want to 

install this hardware. Click the Have disk button. 

 

 
                        Step 12: Select device type.                                                       Step 13: Have a disk. 

 

 

 



Opticstar PL-131 series. © Opticstar Ltd, 2021. 

 
10 Updated: 12/10/2021 

 

14. The next message box with the title Install 

from disk will appear. Navigate to the 

Drivers folder on the CD and click the OK 

button.  

 

15. The camera will be identified as “PL-131 

HighSpeed”. Click the Next button to 

continue. 
           
Step 14: Drivers folder on the CD. 

 

16. Windows may issue an Update Driver Warning. Click the Yes button to continue the 

installation. 

 

  Step 16: Continue the installation. 
 

 

 
 

             Step 15: Select the camera from the list. 

 

17. The following warning message may be displayed: Windows can’t verify the 

publisher of this driver software. Ignore the message and select “Install this driver 

software anyway”. 

 

18. Finally, Windows will confirm the end of the installation with the following message: 

Windows has successfully updated your driver software. 

         Step 17: Select the camera from the list. 
 

 

 
           Step 18: Finished driver installation. 
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Installing etAMCAP 
You can test that the camera has been installed successfully by running the etAMCAP 

program.  

 

 

The etAMCAP.EXE can be found on the 

accompanying CD inside the etAMCAP 

folder. Copy this to your computer’s 

desktop by dragging it from the CD folder. 

 

Double-click the etAMCAP icon on the 

Windows desktop to run the program. 

 

The camera will be identified as PL-131C 

for the colour model or PL-131M for the 

monochrome model. Select the camera 

from the Devices menu. EtMAMCAP can 

be used as a general-purpose program to 

capture video in AVI format. 

 

 

 

 

 

 

 

 

 

Video Capture with etAMCAP 

ROI (region of interest) modes increase the rate at 

which the camera sends the data to the computer 

while preserving the full image quality of the 

selected region. 

 

The camera mode can be selected from the menu 

by selecting Options > Video Capture Pin.  

 

The maximum frame rate that the camera operates 

at depends on the mode selected. 

 

 

 

 

 

 

 

Mode Frame Rate (max) 

1280 x 1024 22 frames per second 

640 x 512 70 frames per second 

640 x 480 ROI 80 frames per second 

320 x 240 ROI 220 frames per second 

EtAMCAP can be used to capture video in AVI format. It cannot 
capture single frames. In order to capture single frames as well 

as video please use Opticstar View.  

Selecting the camera mode and resolution. 
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Exposure Time 

The exposure time can be set by selecting Options 

> Video Capture Filter under the Exposure tab. 

The camera can operate using automatic exposure 

or manual exposure. When using automatic 

exposure, the only exposure related parameter that 

the user can control is Target. The target slider 

gives a delta value, up or down, to the automatic 

exposure used by the camera. Effectively, the user 

can affect the automatic exposure time by setting 

the Target value. The target value can be set 

between 50 and 200. The default value is 100 

which leaves the default exposure time unchanged. 

 

A Target value above 100 will increase the exposure time. A value below 100 will decrease it. The 

Gain value cannot be set by the user when the camera operates in automatic exposure mode. 

 

Manual Exposure Time 

The exposure time can also be set manually by un-ticking the Auto Exposure option. When the 

camera operates in manual exposure mode, the Target value cannot be set since it has no 

meaningful purpose in this context. The Gain value however can be set between 1 and 40. High 

Gain values increase the camera’s light sensitivity. 

 

Timing Units and Exposure Time 

The region of interest (ROI) modes, increase the frame rate dramatically. At 1280x1024 the frame 

rate is 22 frames per second (FPS). When in 640x480 ROI mode the maximum frame rate increases 

to 80FPS. An increase of 3.6 times (80 / 22 = 3.6). The exposure time per frame decreases 

accordingly. Therefore, in 640x480 ROI the maximum exposure time of the camera is 3.6 times 

less. Effectively, it is a trade-off between speed and exposure time (and hence sensitivity). 

Similarly, at 320x240 ROI the frame rate increases to 220 FPS. Therefore, because the frame rate 

increases by ten times, the exposure time per frame is reduced by 10 times (220 / 22 = 10). 

 

The exposure control slide bar always displays the exposure time units between 0 and 3000. These 

units relate to the camera's internal clock rather than actual milliseconds. The range of 3000 units 

specifies different a exposure time depending on the camera mode. When the camera runs in high-

speed mode (the default mode), the maximum frame rates and the exposure times are outlined in 

the table below. 

 

 

 

Mode Frame Rate (FPS) Exposure Time (max) Timing Units 

1280 x 1024 22 500ms 3000 

640 x 480 ROI 80 138ms 3000 

320 x 240 ROI 220 50ms 3000 
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The camera can also operate in standard speed at half the frame rate but double the maximum 

exposure time. In software applications such as Nebulosity, PHD Guiding, AstroArt and MaxIm 

DL the camera operates at standard speed.  

 

 

 

 

 

 

 

 

 

 

Region of Interest 

When the camera operates in ROI modes, the 

user can specify the region of data that will be 

downloaded to the computer by selecting 

Options > Video Capture Filter under the 

Misc tab.  

 

The four arrow keys in the ROI group can be 

used to scroll over the sensor’s active imaging 

area. The selected area is always in full resolution 

but the camera operates at a higher frame rate. 

 

 

 

Colour Synthesis for the PL-131C (colour model) 

Colour synthesis is the process of creating a colour image from raw data. Scientific colour cameras 

use a Bayer matrix on the CMOS/CCD sensor. A Bayer matrix is a series of micro-filters that are 

placed on top of the sensor’s cells (pixels) in order to give it the colour information.  

 

Dedicated astronomy cameras do not incorporate an 

infra-red blocking filter (IR filter) and therefore 

images tend to have a red bias. By capturing light in 

the IR region, the camera can capture data that 

normally would not be visible to the human eye. The 

PL-131C does not incorporate an IR filter for this 

reason.  

 

On the PL-131C, colour synthesis can be adjusted 

manually or automatically. Under the White 

Balance tab, there are three slide bars that can be 

used to adjust the relative strength each colour 

channel: Red, Green and Blue (RGB). It is also 

possible to let the camera perform the colour 

balancing by clicking on the One Push WB button.   

When the camera is set to operate at standard speed (by 
Nebulosity, PHD Guiding, AstroArt and MaxIm DL) it will 

remain at standard speed until the user restarts Windows. Even 
etEMACAP and View will operate at standard speed until 

Windows is restarted. 
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If the user adjusts any of the RGB slide bars, the camera will enter manual white balance mode. To 

revert back to automatic white balance, the One Push WB button must be pressed. 

 

 

Gamma, Contrast and Saturation (colour model) 

Other image properties such as the gamma, contrast 

and saturation of the image can be adjusted by 

selecting Options > Video Capture Filter under 

the Colour Adjust tab. 

 

These values can be set manually by using the 

appropriate slide bars or automatically by ticking 

the Colour Enhancement Enable option. 

 

 

 

 

 

 

Video Capture 

The camera can capture video and store it to disk as an AVI file. The folder and location of the file 

can be selected from the File > Set Capture File menu. In order to start video capture, select 

Capture > Start Capture. Timing during capture can be selected from Capture > Set Frame 

Rate and Capture > Set Time Limit. 

 

 

Post Processing 

There is some freely available third-party software that may be of interest to some users. Please 

note that Opticstar cannot guarantee the suitability the software. 

• Deep Sky Stacker. (http://deepskystacker.free.fr).  

• RegiStax. (http://www.astronomie.be/registax/) 

 

These programs can be used to post-process video files captured in EtAMCAP and View. They 

can stack, align and enhance multiple AVI frames into a single high quality “master” image. 

 

http://deepskystacker.free.fr/
http://www.astronomie.be/registax/
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Installing Opticstar View 
Opticstar View is a more 

advanced software 

application that can be 

used to control the camera, 

capture single frames or video, 

perform image processing and image 

measurements. 

 

View can be used for a wide range of 

applications outside astronomy 

including microscopy. 

 

 

 

 

 

 

 

 

1. To install View, navigate to the View folder on the CD and open the View_setup.exe file.  

 

2. Windows will display “Welcome to the Opticstar View Setup Wizard”. Click the Next 

button to continue. 

 

 
               Installing Opticstar View.                                                  Running Opticstar View.      

 

 

After the installation has finished, View can be run by clicking on the Windows Start button and 

selecting Opticstar View from the programs list. 
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Camera Control 

Run View with the camera connected to the computer. 

On the right-hand side panel of the application, under 

the Capture tab, the camera will be identified as 

“Opticstar PL-131C” or “Opticstar PL-131M”. 

 

By default, the camera will be running as soon as 

View opens. In order to change the image resolution, 

the preview must be stopped by clicking the Stop 

Preview button. This button toggles between Start 

Preview and Stop Preview modes. 

 

The Default button resets the camera settings to the 

default values. 

 

 

 

 

 

 

Frame Rate 

When lower resolution modes are combined with 

manual exposure times, they can increase the frame 

rate (frames per second) at which the camera operates. 

 

 

 

 

Camera Configuration 

The exposure time as well all other camera 

parameters can be configured by clicking the 

Advanced button. This button is situated below the 

Start Preview / Stop Preview button. 

 

A window will appear with three tabs: 

• Color Adjust 

• Explosure 

• Other 

 

The options under each tab are outlined in the 

following sections. 

Resolution Frame Rate (max) 

1280 x 1024 22 frames per second 

640 x 512 70 frames per second 

640 x 480 ROI 80 frames per second 

320 x 240 ROI 220 frames per second 



Opticstar PL-131 series. © Opticstar Ltd, 2021. 

 
17 Updated: 12/10/2021 

Colour Adjustment Tab 

The first three slider bars labelled: R Gain, G Gain and B Gain, can be used to manually adjust 

the red, green and blue colour reproduction of the camera. Alternatively, the camera can 

automatically set these values by pressing the White Balance button. Automatic values may not be 

appropriate in certain circumstances depending on the light conditions, luminosity of the target, etc. 

Other values that are user selectable include Gamma and Contrast. 

 

User defined settings can be stored for future use. There are four sets of parameters that can be 

stored for future use. They are labelled A, B, C and D. Simply select one of them and click the 

Save button.  

 

 

Exposure Tab 

When auto-exposure is used, the user cannot specify 

the exposure time. However, it is still possible to add 

a “bias” by increasing or decreasing the Target value. 

Likewise, the Gain value is not user definable in 

auto-exposure mode. 

 

To set the exposure time manually, simply un-tick the 

Auto Exposure option. In this mode, the time can be 

set in milliseconds and the Gain value can be set 

manually. The Target value cannot be set in manual 

exposure mode. 

 

 

 

 

Other Tab 

All other configuration settings are situated under the 

Other tab. The camera’s frame speed can be set to 

Normal (better image quality) or High (higher frame 

rate). 

 

The way that the camera reads the pixel data from the 

sensor can be set by selecting the Sub Resolution 

option. This has effect only in binning modes. Bin 

Pixels combines the pixel data but Pick Pixels skips 

some of the data on the sensor. 

 

The orientation of the captured images can be 

inverted or reflected by the H Flip and V Flip 

options. The Mono option produces monochrome 

images rather than colour. 
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Image Capture 

There is a second group of user controls on the right-hand 

side panel, headed Camera Capture Config. The Capture 

button can be used to capture a single frame or a series of 

frames in BMP format. The location of the captured files 

and the number of frames can be specified by clicking the 

Config button.  

 

By adjusting these options, it is possible to specify how 

many frames to capture and a time lapse between the 

frames. The captured frames are also displayed as 

thumbnails on the bottom right hand side corner. 

 

Video can be captured in AVI format by clicking the Start 

Video button. This button toggles between Start Video and 

Stop Video. Once the Start Video button has been pressed, 

the camera will capture and store the data on the hard disk 

until Stop Video is clicked by the user.  

 

The location of the stored file(s) can be specified by 

clicking the Config button. By default, video data is stored 

uncompressed in order to preserve high image quality. 

Optionally, it is possible to compress the AVI files by 

clicking the Video Compress button. 

 

Captured images can be processed in View by clicking the Open And Edit button underneath the 

captured image. 

 

The image to be processed should be present in the folder in which the image was stored. This 

folder can be specified by pressing the Config button. 
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Image Processing` 

View can be used to perform measurements on the captured image(s). It is also possible to apply 

various filters and perform image processing operations.  

 

 

A brief outline of View’s image processing functions is listed below: 

• Basic operations including Crop, Mirror, Flip, Invert, Rotate, Bright, etc. 

• Copy and paste user defined regions. 

• Distances can be measured between user defined points, circles, etc. 

• Angles can be calculated by defining three points on the image. 

• Operations can be performed on any user defined region.  

• Colour operations can be performed on individual R, G, B channels. 

• Data combine of two images. 

• Data calibration. 

• Image-zoom as a per cent of the original image. 

• Linear filters to soften, sharpen, emboss, blur and Gaussian. 

• Non-linear filters for median, erode, dilate, contour, edge and jitter. 

• Transform filters for pinch, punch, twirl and cylinder. 

• Fluorescence filters for gamma, colorize, mix and combine. 
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Installing Nebulosity 
To install Nebulosity, navigate to the 

Nebulosity folder on the CD and run the 

setup.exe file. E.g.: D:\Nebulosity\setup.exe. 

Please follow the on-screen instructions. During 

installation tick the appropriate option in order to add an 

icon to the Windows Desktop.  

 

The version of Nebulosity that is bundled with the PL-

131 camera has some of its advanced features disabled. In 

order to enable all the features, a full licence of 

Nebulosity must be purchased. However, the bundled 

version of Nebulosity Lite supports lapse photography, 

1x1, 2x2 and 4x4 binning modes, StarView real-time video preview mode, frame stacking, support 

for all popular file formats and more. 

 

Registering Nebulosity Lite 

Please use the Serial Number shown, to register Nebulosity Lite. The 

Nebulosity user manual is included as a PDF document inside the 

Nebulosity folder on the CD e.g.: D:\Nebulosity\NebulosityManual.pdf. 

 

Opticstar PL-131 Plug-in for Nebulosity 

The PL-131 plug-in for Nebulosity can be found on the supplied CD. 

Navigate to the \Plugins\Nebulosity folder on the CD e.g.: 

D:\Plugins\Nebulosity\PL131C for the colour camera or 

D:\Plugins\Nebulosity\PL131M for the monochrome mode. Copy all the 

files into the folder in which Nebulosity has been installed on the hard disk 

e.g.: C:\Program Files\Nebulosity. The files that should be copied are: 

OSPL130RT.dll and OSPL131CRT.dll for the colour model or 

OSPL130RT.dll and OSPL131MRT.dll for the monochrome model. 

 

Selecting the Camera 
Run Nebulosity and select the camera model from the drop-down menu on 

the right-hand panel. Select it as Opticstar PL-130C (it is compatible with 

PL-131C) or Opticstar PL-130M (PL-131M compatible). Once the camera 

has been selected, set the exposure duration to 1 second as a starting point.  

 

The exposure time should not be set to more than 10 seconds even though 

Nebulosity allows the user to enter much longer exposure times. The camera 

cannot support longer exposure times and hence they are reduced 

automatically to 10 seconds. Exposure times above 1 second do not increase 

the light sensitivity significantly. 

 

Binning Modes 
The camera pixel resolution is 1280x1024. There is support for 4 binning 

imaging modes: 1x1, 2x2 and 4x4. The StarView mode is useful for focusing and previewing. It is 

very well suited for locating targets quickly.  The camera’s built-in Gain function should be set on 

the StarView window (not on the main Nebulosity panel). 

05130 
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Opticstar PL-131 Plug-in for AstroArt 
 Plug-in Version 1.0  

 
In order to add long exposure native support to AstroArt v3/v4 for the PL-131 camera 

you will need to copy D_PL131C.DLL and OSPL131CRT.DLL for the colour 

camera. For the monochrome camera the files to copy are D_PL131M.DLL  and 

OSPL131MRT.DLL.  

 

 

Copy the files from the folder on the CD e.g. 

D:\Plugins\AstroArt\PL131C (colour model) or 

D:\Plugins\AstroArt\PL131M (monochrome 

model) into the folder where AstroArt has been 

installed on the hard disk. For example: 

C:\Program Files\Astroart.  

 

After copying the files, run AstroArt and select the 

PL131C plug-in for the colour camera or the 

PL131M plug-in for the monochrome camera from 

the list.  

 

Binning and ROI Modes 

Within AstroArt the following camera binning/resolution modes are supported.  

• 1x1 binning, 1280x1024 pixels. 

• 2x2 binning,  640x480 pixels. 

• 4x4 binning,   320x240 pixels 

• ROI 640x480 pixels. This is the top left-hand corner of the whole image. 

• ROI 320x240 pixels. This is the top left-hand corner of the whole image. 

 

Selecting regions is only possible on the top three binning modes. The ROI (region of interest) 

modes do not support user selectable regions but they provide the fastest frame rates. 

 

Gain and StarView 

The camera supports hardware Gain. The Gain setting can be set on the StarView window by the 

vertical slide bar. By default, the Gain setting is at 50%. This setting is used by the StarView 

window as well as by AstroArt when it captures images. 
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Opticstar PL-131 Plug-in for MaxIm DL 
 Plug-in Version 1.0 

 

 

In order to add long exposure native support to MaxIm DL for the PL-131 camera you 

will need to copy the plug-in files CCDPlugOSPL131C.DLL and  OSPL131CRT.DLL 

files for the colour camera. For the monochrome model the files are 

CCDPlugOSPL131M.DLL and OSPL131MRT.DLL. Copy the files into the folder where 

MaxIm DL has been installed on the hard disk. For example:  C:\Program Files\Diffraction 

Limited\MaxIm DL V5.  

 

The plug-in files are located on the CD e.g. 

D:\Plugins\MaxImDL\PL131C for the colour 

camera or inside D:\Plugins\MaxImDL\ 

PL131M for the monochrome model. 

 

After copying the files, run MaxIm DL and 

select the Opt PL131C plug-in for the colour 

camera or the Opt PL131M plug-in for the 

monochrome camera from the list.  

 

 

 

 

Binning and ROI Modes 

Within MaxIm DL the following camera binning/resolution modes are supported.  

• 1x1 binning, 1280x1024 pixels. 

• 2x2 binning ,  640x480 pixels. 

• 4x4 binning,   320x240 pixels 

 

The hardware ROI (Region of Interest) modes are not supported in MaxIm DL.  

 

 

Gain and StarView 

The camera supports hardware Gain. The Gain setting can be set on the StarView window by the 

vertical slide bar. By default, the Gain setting is at 50%. This setting is used by the StarView 

window as well as by MaxIm DL when it captures images. 
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Telescope Control and Auto-Guiding with the AG-131 
The AG-131 includes the Shoestring GPUSB interface box that connects the computer to the 

telescope mount for telescope control and auto-guiding. The following sections describe how to 

install the GPUSB and the appropriate software. Before proceeding, please ensure that PL-131 

camera has been installed and tested successfully as explained in the previous sections. 

 

System Requirements 

The following should already be installed: 

Opticstar PL-131 video camera. 

• Optionally: third party software such as AstroArt or MaxIm DL. 

 

Additionally, the following items are needed: 

• A telescope mount with a guide port (ST4 port). 

• The ASCOM software platform for telescope control. 

• PHD Guiding or other software (e.g., AstroArt, MaxIm DL) for auto-guiding. 

 

 

ASCOM Software 

You will need the ASCOM software platform to be able to auto-guide. Although it is not 

always necessary it is recommended that the ASCOM software platform is installed 

before proceeding. The ASCOM platform is freely available and can be downloaded at 

http://ascom-standards.org. Please visit the ASCOM website for more information. At 

the time of writing version 5 is available to download.  

 

 

PHD Guiding 

PHD Guiding supports the PL-131 natively (selectable as PL-130). The program can be 

installed by running the Setup_PHDGuiding.exe file inside the PHD_Guiding folder on 

the CD e.g.: D:\PHD_Guiding\ Setup_PHDGuiding.exe. Once the program has been 

installed, you must copy the Opticstar PL-131 plug-in that will enable PHD Guiding to use the PL-

131 camera in native mode and achieve better image data for guiding. 

 

Installing the PL-131 Plug-in for PHD Guiding 

The camera plug-in used for PHD Guiding is the same one that is used for Nebulosity. Simply copy 

all the files on the supplied CD from the \Plugins\Nebulosity folder e.g.: 

D:\Plugins\Nebulosity\PL131C (colour) or D:\Plugins\Nebulosity\PL131M (monochrome) to 

the folder where PHD Guiding has been installed on the hard disk e.g.: C:\Program 

Files\PHDGuiding\. 
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Selecting the Camera in PHD Guiding 

Select the PL-131 camera (selectable as PL-130) by 

clicking on the camera icon, on the bottom left-hand 

corner of the PHD Guiding panel. please select 

“Opticstar PL-130C” or “Opticstar PL-130M”. 

Longer exposure times increase the camera’s light 

sensitivity. 

 

 

 

 

 

 

Shoestring GPUSB  

Plug the Shoestring device into a USB port. The red LED on the GPUSB should light 

immediately. A “Found New Hardware” balloon will pop up on your monitor. Wait a 

few moments and the text in the balloon should change to say “Your new hardware is 

installed and ready to use”.  

 

Once you have completed the initial installation, you may want to verify that the GPUSB is 

working properly before you begin to use it with your auto-guide software. To do this, you can 

copy and install GPUSBCheck_1p1p0_setup.exe from the Shoestring\GPUSB folder on the 

supplied CD, e.g.: D:\Shoestring\GPUSB\ GPUSBCheck_1p1p0_setup.exe.  

 

This simple software allows you to turn the LED on 

and off, change the colour of the LED from red to 

green, and to control the directional movement of your 

scope mount.  

 
It is intended to allow you to verify that everything is 

working properly. Should you have trouble getting your 

third-party auto-guide software to work; using 

GPUSBCheck will also allow you to troubleshoot your 

setup.  

 

In other words, if everything works with 

GPUSBCheck, then your problem most likely is with 

your third-party software. 
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Assembling your Auto-Guiding Hardware 

Once the PL-131 camera is operational and all software have been successfully installed you will 

be ready to set up your telescope. Please make all the physical connections required with reference 

to the illustrations later in this document. 

 

If you are using two USB cameras at the same time it is advisable that the two cameras are attached 

to different USB controllers. Almost all PCs have two internal USB controllers and four USB 

ports. Every controller is allocated its own bandwidth to be shared by its two USB ports. 

 

Attaching two cameras to the same USB controller will affect performance and speed depending on 

the amount of data that needs to be transferred to the PC. 

 

 
M51: 23.03.2006. by Ulrich Gurschen - 3 minutes exposure without and with Guidemaster guiding 

 

Once you have ensured that your software and hardware is operational you should be able to auto-

guide your mount and telescope. 

 

Please make certain that all your USB devices are properly plugged in. Stretched cables can lead to 

momentary loss of communication than can crash a camera, controller or any other USB device 

connected to your PC. 
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Auto-Guiding 
There are a number of ways you can guide a telescope but there are mainly two ways of doing so. 

The most versatile method is to use two scopes mounted on the same mount, one for imaging and 

the second for guiding. Alternatively, you could use a single scope to perform this function. While 

this method is easier it will limit your choice of locating a suitable guide star. 

 

Imaging and Auto-guiding With Two Scopes 

In general, to be able to auto-guide with the Opticstar AG-131 Auto-guiding Kit you will require 

the following: 

 

1. An imaging camera, i.e., Opticstar DS-616C XL+. 

2. An imaging scope, i.e. A&M 80mm f7.5 Super APO. 

3. A secondary scope for auto-guiding, i.e., 70mm f13 achromat 

4. An ST-4 compatible mount, i.e., Sky-Watcher EQ6 or HEQ5. 

5. ASCOM software platform v5 or later (freely available) 

6. PC with USB2.0 ports running Windows 7/8/10/11. 

7. The Shoestring auto-guide controller and cables, i.e., Shoestring GPUSB kit. 

8. Auto-guiding software, i.e., PHD Guiding, AstroArt, MaxIm DL. 

9. Opticstar PL-131 camera and software drivers. 

 

 

The Opticstar AG-131 auto-guiding kit contains items 7, 8 and 9 in the above list. You will 

therefore also need to provide your own imaging camera, imaging telescope, secondary telescope 

for auto-guiding, PC running Windows 7/8/10/11 and ST-4 compatible telescope mount.  

 

Please note that the secondary scope that is used for auto-guiding would further increase your 

choices for locating a suitable guide star if it was held in brackets, like a huge finder scope. This 

would allow you to easily locate a suitable guide-star even under very difficult conditions. 

 

Shoestring Auto-
guider Control Box 

Main imaging telescope PL131 
camera 

Imaging camera 

PC Windows  

Telescope used for auto-guiding To ST-4 compatible 
telescope mount 

Camera auto-
guiding 
software 

USB cables 
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Imaging and Auto-guiding With a Single Scope 

An alternative setup will involve a single telescope for imaging and auto-guiding purposes instead 

of two different telescopes. As such you will require the following items to be able to image and 

auto-guide. 

1. An imaging camera, i.e., DS-616C XL+. 

2. An imaging scope, i.e. A&M 80mm f7.5 Super APO. 

3. An off-axis guider 

4. An ST-4 compatible mount, i.e., Sky-Watcher EQ6 or HEQ5. 

5. ASCOM software platform v5 or later (freely available) 

6. PC with USB2.0 ports running Windows 7/8/10/11. 

7. The Shoestring auto-guide controller and cables, i.e., Shoestring GPUSB kit. 

8. Auto-guiding software, i.e., PHD Guiding, AstroArt, MaxIm DL. 

9. Opticstar PL-131 camera and drivers. 

 

 

The Opticstar AG-131 auto-guiding kit contains items 7, 8 and 9 in the above list. You will 

therefore also need to provide your own imaging camera, telescope, off-axis guider, PC running 

Windows 7/8/10/11 and ST-4 compatible telescope mount. 

 

An off-axis guider provides an easy and affordable way to auto-guide with a single scope. It 

minimises possible tube flexure but has the disadvantage of having a limited field of view. Also, 

the amount of light that hits the prism/mirror is relatively small making less bright stars more 

difficult to see and track. 

 

Shoestring Auto-
guider Control Box 

Telescope used for both imaging and 
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         Astroport beam splitter                        Vixen off-axis guider                 Celestron off-axis radial guider 
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Troubleshooting  
If you experience difficulty in installing the camera software and drivers this may be due to a 

number of reasons related to your computer, operating system and other devices already connected 

to it. The following sections outline the most common problems and suggest ways in which you 

should be able to solve them. Please also refer to the documents in the Articles folder on the CD. 

 

USB Requirements 

Please ensure that your computer runs Windows 7/8/10/11 or later, has the latest 

updates from Microsoft (inc. Direct X) and also has USB 2.0 ports. The PL-131 camera 

will not work with USB1.1. If your computer has USB1.1 ports you will need to obtain 

a PCI USB2.0 type card if you have a desktop, or an Express USB2.0 card if you have a laptop. 

The ExpressCard will need to be fully supported by your computer, in some entry level laptops full 

ExpressCard support in not fully implemented.  

 

If you have a desktop, try both the USB ports on the front and back of your PC if the camera is not 

recognised on a particular USB port. USB ports attached directly to the motherboard are more 

efficient. Please note that PCMCIA USB2.0 cards typically do not provide the full USB2.0 

bandwidth and will not work with the PL-131 camera. 

 

Express Card 

To resolve such issues an ExpressCard (with USB2.0 ports) should be used instead of a 

PCMCIA/CardBus card due to the ExpressCard's superior speed of 2.5Gbit/s (480 Mbit/s through 

USB 2.0) per slot, for comparison PCMCIA/CardBus devices connected to a computer would share 

a total 1.06 Gbit/s bandwidth. Express type cards use a 34mm slot where PCMCIA/CardBus cards 

use 54mm slots. An ExpressCard should be connected directly to the computer and not via a 

PCMCIA/CardBus card. 

 

Re-Installing the Software Drivers 

If the camera cannot be identified by Windows, then it is 

possible that the software drivers have not been installed 

correctly or they have been corrupted. In such cases, it is 

best to uninstall the camera. This can be done from the 

Device Manager in Windows. 

 

Click on the Start button on the Windows desktop and from 

Settings > Control Panel, select Device Manager. The 

camera should appear in the list under Imaging devices. 

 

1. Right-click on the Opticstar PL-131 entry. 

 

2. On the pop-up menu and select Uninstall.  

 

3. If Windows asks to restart the computer, click yes 

and continue. When the computer restarts, please re-

install the software as normal. 

 

To re-install the drivers please follow the instructions in the 

Installing the PL-131 Driver Software section on page 7 of 

this guide. 
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Support 
For support regarding the PL-131 or AG-131 please email Opticstar at: info@opticstar.com.  

 

Other Software 
There is some freely available third-party software that may be of interest to some users. Please 

note that Opticstar cannot guarantee the suitability the software. 

• Deep Sky Stacker. (http://deepskystacker.free.fr).  

• RegiStax. (http://www.astronomie.be/registax/) 

 

These programs can be used to post-process video files captured in EtAMCAP and View. They 

can stack, align and enhance multiple AVI frames into a single high quality “master” image. 
 
 
 

Microscope Attachments 
In order to use the camera with a microscope, one or 

more attachments must be used. The attachments shown 

from left to right are: C/CS to 23mm (x0.5), C/CS to 

23mm (x1), C/CS to 30mm and C/CS to 30.5mm. These 

attachments are not bundled with the camera. 
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Camera Specification 

Specification PL-131 COOLAIR 

Image sensor 1/2” CMOS 

Sensitivity 1.8v/Lux-sec at 550nm 

Sensor Micron MT9M001C 

Pixel size 5.2μm x 5.2μm 

Max. Resolution 1280 x 1024 pixels 

Speed  22fps  at 1280x1024 
 80fps  at 640x480  
220fps at 320x240 

Data Readout Raw at 8-bit per pixel 
RGB colour 24-bit  

Gain In hardware 

Region of Interest (ROI) 640x480 user definable, 
320x240 user definable 

Binning modes Hardware: 1x1, 2x2 
Software/Hardware: 4x4 

Auto-Exposure Automatic/Manual 

Image Output USB 2.0, 480 Mb/s 

Power Supply USB 2.0 

Lens Mount C/CS Mount 

Mounting Tube 23.2mm 

Lens Mount C/CS Mount 

Mounting to telescope C/CS to 1.25” (included) 

Mounting to lens C to T-thread (M42 x 0.75) 

Mounting to microscope C to 23mm, C to 30mm, C to 
30.5mm  

USB Cable 1.8 meter long 

Weight 250g 

Operation temperature 0ºC to 60ºC 

Computer requirements Windows (32-bit or 64-bit) 
7/8/10/11 
USB 2.0 or later 

Software support Microsoft DirectShow, 
MSB AstroArt, 
Diffraction Limited MaxIm DL, 
Stark Labs Nebulosity 
Stark Labs PHD Guiding 
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